Using the ShadowScribe II Editor: A Guide for the Medical Transcription Editor (MTE)

December 2013
# Table of Contents

How Editing Differs from Transcription ................................................................................................................................. 4

Editing Drafts in the ShadowScribe II Editor ............................................................................................................................... 4
  Draft Generation ............................................................................................................................................................................. 4
  Overview on what to expect when editing ................................................................................................................................. 5
  The Style Guide .............................................................................................................................................................................. 7
  How Editing Influences Draft Quality ..................................................................................................................................... 8

Editing Tools .................................................................................................................................................................................. 10
  Keyboard Shortcuts ....................................................................................................................................................................... 10
  Navigation Shortcuts ..................................................................................................................................................................... 11
  Editing Shortcuts ........................................................................................................................................................................... 11
  Structural Shortcuts ..................................................................................................................................................................... 11
  Playback Shortcuts ....................................................................................................................................................................... 11
  Shortcuts to learn first ................................................................................................................................................................ 11
  The ShadowScribe Menu ............................................................................................................................................................. 12
  The Dictation Menu .................................................................................................................................................................... 13

Overview on Editing ....................................................................................................................................................................... 14
  For Beginning MTEs ..................................................................................................................................................................... 14
  For Advanced MTEs ...................................................................................................................................................................... 15
    Editing With the Voice Cursor Detached ................................................................................................................................. 15
  Editing With the Voice Cursor Attached .................................................................................................................................... 16
  Other Voice Cursor Behaviors .................................................................................................................................................... 17
  Playback Rate ................................................................................................................................................................................ 17
    Changing Playback Rate ............................................................................................................................................................ 17

Editing Best Practices ..................................................................................................................................................................... 18
  Focused Listening ........................................................................................................................................................................ 19
  The Power of Suggestion ............................................................................................................................................................. 19
  Using Draft Output ....................................................................................................................................................................... 20
  Unnecessary Editing .................................................................................................................................................................... 20
  Editing While In Playback .......................................................................................................................................................... 21

APPENDIX A –Shortcuts Keys for ShadowScribe II Editor ............................................................................................................. 22

APPENDIX B - FAQ .......................................................................................................................................................................... 24
  The Voice Cursor ........................................................................................................................................................................ 24
  Sections ....................................................................................................................................................................................... 24
  Creating a List ............................................................................................................................................................................ 25
  Speeding Up and Slowing Down Dictation ............................................................................................................................ 25
Introduction

The ShadowScribe II editor is used for transcribing or editing clinicians using the Emdat ShadowScribe system. This is a new editor built into InScribe which can support both structured and unstructured transcription. Structured transcription is used with voice recognition or with clients who require a section level interface with an external electronic medical record, unstructured is what is used for straight typing without voice recognition. This guide focuses on using the ShadowScribe II editor for voice recognition with structured transcription.

This guide assumes you are familiar with the ShadowScribe II Editor and focuses on what an MTE should expect when editing. It also discusses the skills needed to become an editor. In addition, it also assumes you know how to use autotext, document, and dictation templates. If you are new to the ShadowScribe II Editor, you should read Using the ShadowScribe II Editor: A Guide for the Transcriptionist first before reading this document.

From the MTE perspective, the ShadowScribe II Editor and the ShadowScribe system are both designed to increase your efficiency and improve your editing experience. This is achieved by creating machine transcribed documents, or drafts, that are edited instead of typed from scratch. Since you are not typing the job from scratch, and you can read faster than type, you can be more efficient reading over what is correct and editing what is not correct. This speeds up productivity because you spend less time on typing. Another feature designed to help speed up productivity is that the system can automatically apply many client specific rules, removing many other formatting responsibilities such as having to remember various content and style formatting rules like, dates, times measurements, bolding of section titles, content placement, and more. Having the system perform these tasks frees you to concentrate directly on the medical content of the document and improves productivity.

While the ShadowScribe system has many features built in to make you more efficient and productive, that is only half the equation. To achieve this productivity requires both MT experience and editor experience. You already have the MT experience; this guide will introduce you to the editing skills you need to learn to become a Medical Transcriptionist Editor (MTE).1

NOTE: This guide assumes your shortcut profile is setup to use the VR-Enhanced Shortcuts and will refer to these shortcuts throughout. To make sure you are using these shortcuts go to the Options Menu, select InScribe shortcut keys, and make sure the VR: Use VR-Enhanced shortcuts is checked.
How Editing Differs from Transcription

When you edit, you read, listen, and review the transcription of a machine. This is a different mindset if you are accustomed to transcription. When you transcribe, you work in an environment where your hands are constantly moving, you listen to the dictation and convert words you hear into text. When you edit, the words you hear are already converted to text. You look at words, phrases, sentences, and their context to understand and verify their meaning. As you locate edits you identify the type like structural, grammatical, contextual, etc., and make the edit. When you do this, you involve the integrated skill sets of reading, listening, and typing at the same time. Below are the skills you will need to become a proficient skilled editor.

New skills to adopt as an Editor

<table>
<thead>
<tr>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation</td>
</tr>
<tr>
<td>Editing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Editing During Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize start/stop editing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Optimizing Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speeding up and slowing down dictation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Using the Voice Cursor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading highlighted words</td>
</tr>
<tr>
<td>Attach / detach edit cursor to voice cursor</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Best Practices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attentive Listening</td>
</tr>
<tr>
<td>Avoiding the Power of Suggestion</td>
</tr>
<tr>
<td>Using the draft as a tool</td>
</tr>
<tr>
<td>Reduce over-editing</td>
</tr>
</tbody>
</table>

Editing Drafts in the ShadowScribe II Editor

Draft Generation

Once a clinician is out of training drafts are generated by ShadowScribe. Whether an MT will edit drafts depends on an internal threshold used by the ShadowScribe system. A draft will be produced by the ShadowScribe system and will be internally accessed. If the number of corrections exceeds the threshold, the draft will be sent to an MT to type from scratch, otherwise it will be sent to an MTE to edit.
Overview on what to expect when editing

When you begin to edit a draft, the first thing you see are the section headings and content. The content appears under the section title within the content boxes. Note, there may be are cases where you won’t have section headings. This is usually occurs with letters type documents. In those cases you’ll see paragraphs of text within a single content box.

Whether you’re working on a letter or not, any demographic information like patient name, date of birth, medical record number, etc. if recognized, will not appear in the body of the report.

Even though the ShadowScribe system can recognize demographics, it’s not always successful and therefore cannot automatically populate the demographics. You are still be responsible for filling in this information but with many clients using mobile devices or using patient schedule feeds, filling in the demographics can be done quickly.
Next, in the draft you will begin to review the document and make edits. In some cases edits will be obvious. In the example below, you notice the Past Surgical History section, has the medications section misrecognized as text, highlighted in yellow. Also you’ll notice a list was misrecognized because you can see that by the words “number one”, “number two”, highlighted in blue. Note the highlighted text is for illustration purposes, it is not actually added by ShadowScribe.

### PAST SURGICAL HISTORY:

- Colostomy.

[Medications] number one Lipid lowering agent number two Blood pressure medications and diabetes.

### ALLERGIES:

She has no known drug allergies.

To correct this you would highlight the medications section and use **CTRL+N** to make that a section.

#### Medications

- number one Lipid lowering agent number two Blood pressure medications and diabetes.

Next, you would use **Ctrl+L** to make the sentence into a list, removing the words “number one”, “number two” with **Ctrl+Delete**, to create your list items and complete your edits.

#### Medications

- Lipid lowering agent
- Blood pressure medications and diabetes.

All of these edits are done quickly with a few simple keystrokes. Less keystrokes lead to improved efficiency and faster editing.
Other edits may not be as obvious, but as you play back the dictation and read the text you will find them. Lastly, you will notice the Voice Cursor (see screenshot below). The Voice Cursor moves over the text as the audio is played back and gives you a visual reference point of where playback is in relation to the text. It will help focus your attention as you read the words and listen closely to the dictation. The voice cursor also helps improve editing efficiency because it can carry the edit cursor during playback. When an edit is encountered the edit cursor can be separated to make the edit. For more information see the “How to Edit” section” of this document.

The Style Guide
The style guide determines the rules ShadowScribe follows when formatting a draft. These are things like abbreviations, dates, times, quantities, and number formatting to name a few. Rules like these are nothing new to an MT. When you start on a new client, your account manager has a set of rules to follow specific to the client’s requirements. These rules usually contain information on how to handle blanks, specific clinician preferences, and how to format content among others. The Style Guide focuses on the content formatting. It takes much of this formatting that you were responsible for and shifts it to the ShadowScribe system. For example, the client may require you to format dates in numeric format rather than spelled out. So if the clinician dictated “January first, two thousand thirteen” the system would format that as 01/01/13 instead of January 1st, 2013. Because formatting is applied automatically, you save time and keystrokes, and can focus more on the transcribed text.

Examples of some Style Guide rules

**Abbreviations/Acronyms**
Transcribe all abbreviations and/or acronyms as dictated.
- Do not expand unless they are dictated in their expanded state.
- Do not abbreviate unless dictated as an abbreviation.

**Contractions**
Transcriptionists should expand contractions when they are spoken unless in a direct quote.

**Examples:**
Dictated: He’s a vegetarian.
Transcribed: He is a vegetarian.

OR
Dictated: The patient was murmuring, “I’m a diabetic.”
Transcribe: The patient was murmuring, “I’m a diabetic.”
Dates
When a full date is dictated, which would include Month, Day & Year, such as January 27, 2010 or "the 27th of January, 2010, dates should be transcribed with a concise day, month spelled out, with a 4-digit year, in dd mm yyyy ex: 27 January 2010

If only Month and year, i.e., January of 2010, transcribe as January 2010.

If only Month and Day,

i.e., January 27th, transcribe as 27 January.
OR
"17th of January", transcribe as 17 January.

Depending on the accounts you work on, you will be given one more style guides by your transcription company manager. Be sure to learn the style guide for your clients and stick with the style as much as possible. When typing and editing, consistency is key. The speech engine will learn from consistent typing and editing. Keeping your work consistent and in line with the style guide leads to better draft quality, more efficiency in the work environment, and higher production rates.

How Editing Influences Draft Quality
When you edit, you review and make corrections to the draft where needed. Once you make all corrections and the draft is delivered to the client and also back to the ShadowScribe system for analysis. The original draft is compared with the corrected one and adjustments are made to improve draft quality over time. Keep in mind not all clinician drafts will improve at the same rate some will improve faster than others, or some may only improve to a certain extent. The rate of improvement depends on factors such as sound quality of the audio file and speaking environment, clinician dictation habits, and consistent MTE edits.

As you edit, the changes can be to content, structure, or both. In the screenshot below, content refers to the actual text of the document that appears within the content boxes, while structure refers to skeleton of the document, the section or subsection headings which put the transcription into logical order. The bullets of a list are also part of the structure.
In some cases, you may be editing content correcting misrecognized words, phrases, or sentences. In other cases, you may be editing for structure. Maybe you need to add or remove a section, or complete a misrecognized list. Regardless of the type edit, any change to the original draft will be analyzed by ShadowScribe to help the system learn and improve draft quality over time.

The illustration below shows the relationship between editing and draft quality.
Editing Tools

Keyboard Shortcuts
Keyboard Shortcuts are one of the big keys to efficiency. When you edit you want to rely on the mouse as little as possible. It may not seem like a lot of effort to use the mouse, but consider this. If you move your hand from the keyboard, to the mouse, position the cursor, then move your hand back to the keyboard, that causes you to lose seconds which add up to minutes throughout the day. Those minutes could be the difference of a few more reports completed by the end of the day vs. what you normally would have completed.

To get an idea of this, take a look at this simple example. Imagine your edit cursor is after the word “Cole” highlighted in green and you want to delete the word “leukocytosis” highlighted in yellow.

<table>
<thead>
<tr>
<th>REFERRING PHYSICIAN:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr. Cole</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>REASON FOR CONSULTATION:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fever and leukocytosis.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HISTORY OF PRESENT ILLNESS:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The patient is a 53-year-old Hispanic female. She was admitted to the hospital and transferred for cardiac issues</td>
</tr>
</tbody>
</table>

These are the steps to making the edit using the mouse:
1) Remove hand from keyboard.
2) Place hand on mouse.
3) Move mouse to the word “leukocytosis.”
4) Highlight the word “leukocytosis.”
5) Move your hand off the mouse and back to the delete key on the keyboard.
6) Press delete.

Now, compare that using only the keyboard:
1) Use Ctrl+F to bring up find dialog.
2) Type the word “leukocytosis” in find dialog, click find and the word is highlighted.
3) Hit Escape and Hit the delete key.

Notice the difference. Using the keyboard we didn’t lose any seconds moving hand to/from the keyboard. We kept our hands on the keyboard the entire time and we did the same edit in half the steps.

High productivity gains are achieved when incorporating keyboard shortcuts with editing. Compare that to regular typing. Since a report is typed from scratch you are constantly creating keystrokes to produce the report, there isn’t much opportunity to use keyboard shortcuts because everything first has to be transcribed. When editing all of the text is already transcribed leaving you to navigate and make edits with your keyboard shortcuts.
Navigation Shortcuts
These shortcuts are meant to take the place of the mouse to increase efficiency. You will use these to quickly and efficiently move around the draft document to get to edits.

Editing Shortcuts
Use these shortcuts to delete whole words instead of characters, select words, and move words around. These shortcuts can help you quickly make edits, fixing typos and errors.

Structural Shortcuts
These shortcuts are used to change the structure of the document. Use these to efficiently add or remove sections/subsections, convert content into sections/subsections, convert sections/subsections into content. Use these to also manipulate lists. You can add/remove list items and convert content into list items or list items into content.

Playback Shortcuts
While you can use the foot pedal to control playback, if you are planning on editing you are encouraged to use the playback keyboard shortcuts. By using the keyboard you get into a better mindset because all playback, as well as typing and editing functions, are controlled from one place.

The keyboard has shortcuts to play, stop, rewind and fast forward and there are shortcuts that allow you to control the playback speed. As you become comfortable with editing you will find these shortcuts compliment editing and navigation shortcuts nicely and can further help efficiency.

Shortcuts to learn first
You are NOT expected to learn all shortcut keys at once. Start off slowly; learning a few keys, putting them into practice and work with them until you are comfortable, then add a few more. This takes time, practice, and most importantly, the desire to learn. Below are the recommended shortcuts and order you should start with. Once you are proficient with these then you can move on to others. See the Shortcut Reference dialog in InScribe for more shortcuts. To access this, go to the View menu and select Show Shortcut Reference or use the shortcut Shift+Ctrl+S.

1) Navigation Keys (Paragraph and Words Within Content boxes)
- Ctrl + ↑ Move Edit Cursor Up one Paragraph
- Ctrl + ↓ Move Edit Cursor Down one Paragraph
- Ctrl + → Move edit cursor one whole word right
- Ctrl + ← Move edit cursor one whole word left

2) Navigation Keys (Larger Movements)
- Tab Move to the next content box
- Shift + Tab Move to the prior content box
- Ctrl + Alt + Home Move edit cursor to the top of report
- Ctrl + Alt + End Move edit cursor to the bottom of report
- Ctrl + Home Move edit cursor to top of content box report
- Ctrl + End Move edit cursor to bottom of content box report
- Home Move edit cursor to beginning of line
- End Move edit cursor to end of line

3) Editing Keys
- Ctrl + Delete Delete one whole word right of edit cursor
- Ctrl + Backspace Delete one whole word left of edit cursor
- CTRL + X, C, V, Z Cut, Copy, Paste, Undo
- CTRL + U Shift case of word between Sentence Case, Lower Case, and Upper Case
- SHIFT+____ Add Shift to any of the navigation keys for selection. E.g Shift + Ctrl + → to select one whole word right
The ShadowScribe Menu

This menu will appear each time a ShadowScribe user’s dictation is loaded and contains functions specific to the ShadowScribe II editor. This menu list all of the shortcuts and functions for controlling the structure of the document.

1. **Add Section at Cursor.** Inserts a section title with content box below the current cursor position. If the cursor is in the middle of a sentence, all the words from the right side of the cursor will be moved to the new content box.

2. **Add Sub-Section to Current Section at Cursor.** Inserts a subsection title, with content box, below the current cursor position. If the cursor is in the middle of a sentence, all the words from the right side of the cursor will be moved to the new content box.

   **Note:** To add another subsection you will use the Ctrl+N option instead of the Shift+Ctrl+N. Each time the Shift+Ctrl+N is used a new subsection will be added but at a lower structured level than the prior. To get the section you add back to the main level use Promote Subsection to Section.

3. **Remove Current Section (Merge with Prior Section).** Changes the current section title into content and moves that title to the prior section content box. If the section had text before it was removed, that text is also move to the prior content box.

4. **Edit Section Name.** Changes the name of a section or subsection title. When this is used you can change the name by selecting a new title from the drop down list or by manually typing in a title.

5. **Promote Sub-Section to Section.** Shifts the subsection up a level to the next main level. This is used when adding a new main section using Ctrl+N. The main section is added but appears as a subsection. Using promote Sub-Section to section will move the section up to the next main level.
6. **Demote Section to Sub-Section.** Shifts a main section down to a subsection level. This is used if a main section was added but needed to be a subsection.

7. **Move Section Up.** Moves an entire section and content box above the previous section. This will only move the section up or down on the current level you’re working on. For example, you cannot move a subsection above a main section level. To do that, you must first promote the subsection to a main level.

8. **Move Section Down.** Moves an entire section and content box below the next section. This will only move the section up or down on the current level you’re working on. For example, you cannot move a subsection below a main section level. To do that, you must first promote the subsection to a main level.

**The Dictation Menu**

This menu appears in both regular typing and editing. Most of the functions are pretty self-explanatory, except the Voice Cursor options.

1. **Attach Edit Cursor to Voice Cursor.** While the audio is playing, attaches the flashing edit cursor to the gray voice cursor that moves along each word. Once attached, the voice cursor turns to the blue editing highlight color.

2. **Move Voice to Cursor.** Moves the gray voice cursor to the location of the flashing edit cursor and automatically resumes playback from that point.
Overview on Editing

Whether you’re new to editing or a seasoned editor, your first goal is to make sure the document you deliver is a high quality medically accurate document. Then your next goal is to do it as efficiently as possible, with the fewest amount of keystrokes.

For Beginning MTEs

Before you start working on your first job, it is recommended you select the Options menu, select InScribe Shortcut Keys, and set your shortcuts to use VR Enhanced Shortcuts. This will setup InScribe with the shortcuts recommended for editing. This was already mentioned at the beginning of this guide but it’s important enough to mention it again. See below. If you are installing InScribe for the first time, these shortcuts should be selected already.

In addition, it may be helpful to set your Rewind after Pause option to zero to keep the cursor positioned on your last edit instead of rewinding back five seconds. This setting is also on the Options menu located under the Set Date/Time Values.

When you start working you begin by reading, listening, looking for edits. You also will notice the voice cursor as it moves over the content of the document but will probably not use it much as a beginning MTE. Most of your focus should be on locating edits, moving to them efficiently with your navigation shortcut keys, and making the edit. When you make the edit your natural tendency may be to stop the audio and that’s okay. Your work pattern should be to locate the next edit, decide the type of edit – structure or content and execute it. Then move on until you have made all corrections in the draft. Once you get familiar with this technique, you may start to pre-edit drafts. Looking for obvious edits, making those first before you start playback.

Over time, as you practice and gain experience you should become more comfortable with the navigation keys and become less reliant on the mouse. You will start adding some of the editing shortcuts. You will begin to learn little efficiency tricks such as deleting whole words instead of single characters. You will start to get a feel for the best times to use select, cut, copy, and paste, and undo. As you become more and more comfortable you will begin learning to
make certain edits without stopping the audio, and start to minimize replaying certain portions of the audio. Though experience, you will learn when it’s appropriate to keep the audio going while making the edit and when the audio should be stopped to make the edit.

Remember, these editing behaviors will not happen overnight. It takes time and practice. The more you practice the more proficient you will be.

For Advanced MTEs
Once you feel proficient with navigation and editing shortcuts, you can introduce the use of the voice cursor. This feature has several different functions to help increase your efficiency further. First, it allows your eyes to follow along with each word as it is played, which helps you listen and read more efficiently. Second, when used with the Attach Edit Cursor to Voice Cursor option, it keeps your edit cursor moving with the text allowing you to navigate more efficiently to edits, while keeping the edit cursor close by. Third, it can be used to start playback from virtually any word in the draft. Having this ability eliminates the need for fast forward and rewind. Fourth, for those tough to hear spots, it can be used to re-play a portion of the audio without having to rewind. Finally, it provides a reference point to return to when you read ahead.

Editing With the Voice Cursor Detached
As the voice cursor moves over each word, your eyes follow along looking for edits. When an edit is found, use your navigation keys to locate the edit then use your edit shortcut keys to make the edit, the voice cursor will continue moving forward as you make the edit. If you need to pause the dictation do so while you make the edit, if you can make the edit while the playback is going then the voice cursor will continue to move forward but you can pull that back using Shift+Ctrl+Space, for more information in this see the next section “Editing With the Voice Cursor Attached”. In the example below, you would do the following:

1. Starting from the word “admitted” (highlighted in gray), use F2 to pause the dictation. Use Ctrl+← until your edit cursor is in front of the word “male”.

2. Type a “fe” to make that word “female”. You know this is correct because of that’s what was dictated in the audio and you confirmed the patient is a female.

3. Use Ctrl+→ to move one word to the right until you reach the word “He”.

4. Hold down the Shift+Ctrl+→ to highlight the entire word “he”.

5. Type “She” and resume playback.

As playback continues, you watch the voice cursor until you come upon your next edit and perform similar steps to navigate to and make the edit. You continue in this manner until all the edits have been made.
Editing With the Voice Cursor Attached
A more advanced technique is to attach your edit cursor to the voice cursor using the \texttt{Ctrl+Space} shortcut. This combines the edit cursor with the voice cursor so they act as one. You will know you have them attached because the voice cursor will change to blue. Having the edit cursor attached during playback keeps it right where you need it ready to make an edit. When you are ready to make an edit separate the cursor from the voice cursor by using any key, but the arrow keys work best.

<table>
<thead>
<tr>
<th>REFERRING PHYSICIAN:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr. Cole</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>REASON FOR CONSULTATION:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fever and \texttt{leukocytosis}</td>
</tr>
</tbody>
</table>

In the example below the audio is playing and the edit cursor is attached using \texttt{Ctrl+Space}. Reading ahead, you see that “Dr. Clinic” (outlined in red) does not look right. Listening to the audio, you hear “Dr. Glick”. To make the edit you do the following:

1. Separate your edit cursor from the voice cursor using any of the arrow keys

2. Navigate to the word “Clinic”, use \texttt{Ctrl+Backspace} to delete the word and then type “Glick”.

<table>
<thead>
<tr>
<th>HISTORY OF PRESENT ILLNESS:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The patient is a 31-year-old female with a history of pseudotumor cerebri and chronic headaches as well as history of seizures diagnosed as pseudoseizures. She has a history of ongoing headaches which have been difficult to control. She initially had an I.P. shunt in place for several years. This was eventually changed VP shunt 2011. She was followed by neurosurgery, \texttt{Dr. Clinic} at hospital \texttt{where} Dr. Jones near her as well as Dr. Jones in neurology clinic. She has recurrent admission for headaches. At one point the value of her shunt was changed in May of 12, her shunt became infected and was removed. She has been without shunt since that time. She follows at Lawndale center as well as intermittent appointments with Dr. Jones. Neurology. She has been referred to the neurology neurosurgery an appointment has been made, but for some reason she is not</td>
</tr>
</tbody>
</table>

3. Bring the playback back to where you made the edit using \texttt{Shift+Ctrl+Space}.

4. Start Playback and use \texttt{Ctrl+Space} to reattach your edit cursor and repeat for each edit.

\texttt{Shift+Ctrl+Space} will bring the playback to where you made the edit, but it also will let you playback from virtually any word in the draft. This is an efficient technique because you do not have to rely on rewind to re-listen to identify the edit. Use the feature while the dictation is in playback; position your cursor at the desired location and hit \texttt{Shift+Ctrl+Space}. Alternatively, while the playback is paused, you can move your cursor to any word, and hit \texttt{Shift+Ctrl+Space}. This will position the voice cursor over the word and start playback from that point when you hit \texttt{F2}.

Editing with the voice cursor can be difficult at first while trying to minimize start/stop editing. It’s natural in the beginning to stop playback, make the edit, and then resume and there is nothing wrong with that. However, as you practice this technique, over time you’ll want to learn to minimize start/stop editing as much as possible. Combining this technique with controlling the rate of playback, will help you to achieve this goal. When you slow down the dictation and use the voice cursor you can keep up better with the dictator and minimize stop start editing. For more on playback rate see the Playback Rate section of this document.
Other Voice Cursor Behaviors

In addition to the default method of attaching the edit cursor to the voice cursor using Ctrl+Space, there are some other methods that you might want to try. They are: Attach Voice Cursor on Play, Attach Voice Cursor on Rewind/FF, and Attach Voice Cursor on Jump to Index. You can find these settings under Options, ShadowScribe Options dialog, the Voice Cursor options will be at the bottom.

Attach Voice Cursor on Play: when checked will attach your edit cursor to the voice cursor immediately after you hit play. Many MTs who use foot pedals prefer this behavior over the traditional method.

Attach Voice Cursor on Rewind/FF: when checked will attach your edit cursor to the voice cursor immediately after you hit rewind or fast forward.

Attach Voice Cursor on Jump to Index: when checked will attach your edit cursor to the voice cursor immediately after you jump to an index mark in the report.

Playback Rate

Changing Playback Rate

Another efficiency tool is adjusting playback rate, which allows you to modify the playback speed. You can speed up, slow down, or return the dictation using the keyboard shortcuts: Ctrl+T, Ctrl+E, and Ctrl+R. Use Ctrl+T to speed up the dictation. This is typically used when dictators speak slowly. Why stay at the same pace as the speaker if you can speed up a slow dictator? If you come to a section that has more edits or you can’t understand the dictator you can always slow down the rate. Speeding up on these dictators allows you to move through the draft quicker and more efficiently. This option is great to use with more consistent dictators where less edits are needed. Use Ctrl+E to slow down the dictation. This is used on fast dictators, or bad dictators where more edits are needed. Slowing down also gives you time to think about which keystroke to use to make the edit. Use Ctrl+R to return the playback rate to normal. One example where this would be used, you sped up the playback to quickly re-read a particular section and you want to bring the playback to normal.

Knowing how to change the rate of playback gives you another way to increase productivity. Anytime you can make an adjustment to the speed can go a long way to improving efficiency.
**Editing Best Practices**

Learning to edit efficiently takes time and practice. To get the most out of your practice, it’s recommend to be editing at least 75% or more of your working time. As you begin to edit, the first skill set to master are the **keyboard shortcuts**. Most MTs report their biggest efficiency gain once they master their keyboard shortcuts. Once the shortcuts are mastered, then build upon other skill sets like editing with playback, using the Voice Cursor, etc. The key is to get a skill set mastered before adding another one. The skill sets in the illustration below build from the top down starting with Keyboard Shortcuts and moving down from there.

Up to this point, this document has covered all the skill sets except for the Best Practices. Throughout the remainder of this document, you will learn more about the Best Practices. Take note to how all are related and build off each other.

**Skill Sets**

- **Keyboard Shortcuts**
- **The Voice Cursor**
- **Changing Playback Speed**
- **Editing While In Playback**
- **Best Practices**
  - Focused Listening
  - The Power of Suggestion
  - Using Draft Output
  - Unnecessary Editing
Focused Listening

Focused listening, is making a conscientious effort to really listen to what the clinician is saying. There is a difference between hearing and listening. When you hear something your notice sound but you don’t engage in it, that is you do not actively think about what you are hearing. When you listen to something, you notice sound and actively focus your listening, thinking about what you are hearing. For example, somebody gives you directions to a restaurant that you’ve never been to before, but you don’t listen you just hear what they say without thinking you wouldn’t know how to get there. Sure you might have picked up a few of the instructions but the parts you didn’t get, you mind might make assumptions thinking incorrectly to fill in the missing information. The same is true with editing, if you don’t listen to the audio and read the text and make an effort to focus and think on what is being said you may miss some important edits.

This skill shouldn’t be anything new to the MT who does traditional transcription, but in the editing world it becomes more important because not focusing your listening may lead to mistakes like missing edits or transcribing words incorrectly. When you edit, it’s important to listen to the spoken words but it’s also equally if not more important to listen for context of those spoken words. This will enhance your ability to quickly locate edits in draft documents.

Focused Listening Goals

• Use to help document accuracy and quality
• Listen for context to help you transcribe and edit productively.

The Power of Suggestion

What is the power of suggestion? It’s when you hear and read what you think are the same, when actually they are not. At one time or another, we’ve all run across a case when we transcribed something we thought was correct only to re-listening to it and hear something different. When we don’t focus our listening, we can sometimes misunderstand what we hear. This situation is what is commonly known as the Power of Suggestion.

Here are some examples:
Dictated: “drug eluting stent”
MTE heard: “drug-alluding stent”

Dictated: “ejection fraction”
MTE heard: “injection fraction”

Dictated “Dr. Benitez”
MTE heard: “Dr. Bonitas”

With editing the power of suggestion can be more of an issue because all words are transcribed and if not paying close attention to the audio and text matchup you can easily be misled into thinking you heard and saw what was correct when it wasn’t and miss an edit.

By focusing your listening on content, you can avoid the Power of Suggestion.

Power of Suggestion often occurs with:

• Sound-alike Words
• Messy Dictation
• Accented Dictators
• Repetitions
• Self-corrections
Using Draft Output

A major advantage to editing is having the entire transcribed draft output. This can be a valuable tool when editing for these reasons:

- **You know what’s said**
  - Have entire transcribed draft
  - Can make editing decisions based on what is said

- **You can review the draft before listening**
  - Can make obvious edits such as
  - Missed section, left/right discrepancies, insertion of dication template, fixing unidentified list, etc.

- **You have all of the sentences and phrases**
  - Can easily read and get the context of what is said
  - Helps in decision making process in various edit situations

- **You can learn new terms**
  - ShadowScribe may output new terms unfamiliar to you
  - Can use this as a starting point to research

Using the draft output can provide many advantages to the editing environment and make you a more productive and efficient editor.

Unnecessary Editing

Unnecessary editing is making corrections to a draft to make it more readable, but doesn’t affect medical accuracy or meaning. When transcribing, it’s easy to change what is spoken as it is typed, improving grammar, readability, and in general, making clinician reports look better. When editing drafts, this is not easy or recommended. The ShadowScribe system produces highly accurate results which gets most of the words right. In cases where the draft does not exactly match the dictation but the meaning is close, an MT should focus on the meaning of the dictator’s words and consciously avoid making an edit if it’s done for cosmetic reasons. The most productive editors are those who make edits which are necessary to the medical accuracy of the report.

Unnecessary editing often involves changes to grammar, punctuation, dictation style, and readability. The job of the MTE is to ensure the medical accuracy of the submitted document, not to unnecessarily pretty up the document.

Goals of Unnecessary Editing

- Edit for content, not cosmetics.
- Make necessary edits, edits that are needed to make the report medically accurate.
- Save keystrokes and improve efficiency.

If uncertain, always edit:

- Discrepancies such as Left or Right, or Gender Discrepancies
- Measurements in Lab Results
- Inconsistencies in Medication Dosages
Editing While In Playback
This is exactly what it sounds like, editing while the audio is playing while minimizing start/stop editing. Using the voice cursor with the edit cursor attached is the key. This lets you automatically navigate to edits without having the edit cursor follow the voice cursor. This gives your hands a rest because they are not constantly moving, instead they wait for the edit to emerge. When an edit is found, separate the edit cursor using any key, arrow keys work best, and make the edit. While you make the edit the audio and voice cursor will continue forward, concentrate on your edit. When you are done, bring the audio back to your edit cursor position by using Shift+Ctrl+Space. If you feel the playback is getting ahead to fast, slow it down with Ctrl+E instead of trying to stop the audio.

Goals of Editing While in Playback
- Minimize stop/start editing
- Try to keep edits less than 6 keystrokes during playback
- Increase efficiency and productivity

What helps with editing in playback?
- Use Attach Edit Cursor to Voice Cursor
- After edit, moving playback to cursor position
- Use Keyboard Shortcuts
- Make small edits during playback and work up to more complicated edits
- Practice this skill often

Remember:
- CTRL+Space – Reattach the edit cursor to the voice cursor while audio is playing
- CTRL+SHIFT+Space – Bring the voice cursor to the edit cursor position
- Any key or arrow keys – Separate the voice cursor from the edit cursor
## APPENDIX A – Shortcuts Keys for ShadowScribe II Editor

<table>
<thead>
<tr>
<th>Structure Keys</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ctrl + N</strong></td>
<td>Add Section at Cursor</td>
</tr>
<tr>
<td></td>
<td>- Insert section</td>
</tr>
<tr>
<td></td>
<td>- Change section into text</td>
</tr>
<tr>
<td><strong>Shift + Ctrl + N</strong></td>
<td>Add Subsection at Cursor</td>
</tr>
<tr>
<td></td>
<td>- Insert subsection</td>
</tr>
<tr>
<td></td>
<td>- Change text into subsection</td>
</tr>
<tr>
<td>*<em>Shift + Ctrl + *</em></td>
<td>Remove Current Section (Merge with Prior Section)</td>
</tr>
<tr>
<td></td>
<td>- Convert a section title into text</td>
</tr>
<tr>
<td><strong>Ctrl + F6</strong></td>
<td>Edit Section Name</td>
</tr>
<tr>
<td></td>
<td>- Change the name of a section or subsection title</td>
</tr>
<tr>
<td><strong>Ctrl + .</strong></td>
<td>Promote Subsection to Section</td>
</tr>
<tr>
<td></td>
<td>- Shift current subsection into main section</td>
</tr>
<tr>
<td><strong>Ctrl + ,</strong></td>
<td>Demote Section to Subsection</td>
</tr>
<tr>
<td></td>
<td>- Shift main section into subsection</td>
</tr>
<tr>
<td><strong>Ctrl + Alt + + ,</strong></td>
<td>Move Section Up</td>
</tr>
<tr>
<td></td>
<td>- Moves a section above previous section within current level</td>
</tr>
<tr>
<td><strong>Ctrl + Alt + .</strong></td>
<td>Move Section Down</td>
</tr>
<tr>
<td></td>
<td>- Moves a section below next section within current level</td>
</tr>
<tr>
<td><strong>Ctrl + L</strong></td>
<td>Toggle List</td>
</tr>
<tr>
<td></td>
<td>- Insert bulleted list</td>
</tr>
<tr>
<td></td>
<td>- Change text into bulleted list</td>
</tr>
<tr>
<td></td>
<td>- Change bulleted list into text</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Navigation Keys</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ctrl + ↑</strong></td>
<td>Move edit cursor up one paragraph</td>
</tr>
<tr>
<td><strong>Ctrl + ↓</strong></td>
<td>Move edit cursor down one paragraph</td>
</tr>
<tr>
<td><strong>Ctrl + →</strong></td>
<td>Move edit cursor one whole word right</td>
</tr>
<tr>
<td><strong>Ctrl + ←</strong></td>
<td>Move edit cursor one whole word left</td>
</tr>
<tr>
<td>Tab</td>
<td>Move to the next content box</td>
</tr>
<tr>
<td><strong>Shift + Tab</strong></td>
<td>Move to the prior content box</td>
</tr>
<tr>
<td><strong>Ctrl + Alt + Home</strong></td>
<td>Move to the top of the report</td>
</tr>
<tr>
<td><strong>Ctrl + Alt + End</strong></td>
<td>Move to the bottom of the report</td>
</tr>
<tr>
<td><strong>Ctrl + Home</strong></td>
<td>Move edit cursor to top of current content box</td>
</tr>
<tr>
<td><strong>Ctrl + End</strong></td>
<td>Move edit cursor to bottom of current content box</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td>Move edit cursor to beginning of line</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Move edit cursor to end of line</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Selection Keys</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ctrl + Shift + →</strong></td>
<td>Select one whole word right of edit cursor</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + ←</strong></td>
<td>Select one whole word left of edit cursor</td>
</tr>
<tr>
<td><strong>Shift + ↑</strong></td>
<td>Select whole lines above edit cursor</td>
</tr>
<tr>
<td><strong>Shift + ↓</strong></td>
<td>Select whole lines below edit cursor</td>
</tr>
<tr>
<td><strong>Shift + Home</strong></td>
<td>Select words left of edit cursor to beginning of line</td>
</tr>
<tr>
<td><strong>Shift + End</strong></td>
<td>Select words right of edit cursor to beginning of line</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Commonly used Editing Keys</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ctrl + Delete</strong></td>
<td>Delete one whole word right of edit cursor</td>
</tr>
<tr>
<td><strong>Ctrl + Backspace</strong></td>
<td>Delete one whole word left of edit cursor</td>
</tr>
<tr>
<td><strong>Ctrl + X, C, V, Z</strong></td>
<td>Cut, Copy, Past, Undo</td>
</tr>
<tr>
<td><strong>Ctrl + U</strong></td>
<td>Change case of a word or phrase</td>
</tr>
<tr>
<td><strong>Shift+ Ctrl + F</strong></td>
<td>Find word or phrase</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Ctrl + Alt + M</td>
<td>Move to Comment</td>
</tr>
<tr>
<td>Alt + ;</td>
<td>Move edit cursor between demographics and transcription</td>
</tr>
<tr>
<td>Ctrl + Alt + B</td>
<td>Preview transcription with template</td>
</tr>
</tbody>
</table>
APPENDIX B - FAQ

The Voice Cursor

What is the voice cursor?
The voice cursor is a feature of the ShadowScribe II Editor. As the audio plays, the voice cursor will automatically move from word to word as the speaker dictates.

What does the voice cursor do?
The voice cursor has four functions:

- Allows the MTE to follow the text of the draft, making it easier to read and listen.
- It can carry your edit cursor when you attach it, allowing you to read and navigate to edits.
- It allows you start playback from virtually any word in the draft.
- It allows you to loop part of the audio without using rewind, when you need to replay a difficult section of text.

The voice cursor carries the edit cursor as it moves over each word, keeping the edit cursor at the ready when an edit is near. This makes it so the MT doesn’t have to manually move the edit cursor, and the edit cursor stays in time with the audio playback, making editing easier. Because the edit cursor is attached while the audio is playing, makes it so the MTE can edit during playback.

How do you separate the voice cursor and the edit cursor?
As the audio is played, the voice cursor will appear as a gray highlight, highlighting each word. When you attach your edit cursor that gray highlight becomes blue, this signifies the edit cursor is attached.

To separate the edit cursor, tapping any key on the keyboard will work, but the arrow keys work the best. You’ll know the edit cursor is detached because you’ll see the blue highlight color change back to the gray highlight color.

How can you reattach the edit cursor to the voice cursor?
To reattach the edit cursor, use CTRL+ Space.

Sections

What is a section?
A section refers to both a section title and a corresponding content box. The content box appears below the title and is where transcription text is typed or edited.

How do you make a new section?
You can create a new section by placing your cursor within a content box and typing Ctrl+N.

My section title should be bold. How do you do that?
Formatting of section titles is done automatically when you submit the report via the predefined formatting template. There is no need to bold, or make any other formatting changes, to section titles or subsection titles.

After inserting a title, the section title content box appears red. Why?
If your section title content box is red, this means that it is not one of the predefined sections for the document type. Predefined sections are displayed in your drop down when you use Ctrl+N for sections.

Usually you only need to add a red section if the dictator spoke a different section that was not in the predefined
list. This can happen from time to time. If this happens frequently you should notify your account manager and have them add the section to your pop up list.

**How do you know which section title to add?**
When you create a new section title, press **Ctrl+N** for a list of predefined section titles. Choose the title from the list that is dictated. If the dictated title is on in the list, then add it manually.

**When you do CTRL+N or SHIFT+CTRL+N there are many titles, how do you select the best one?**
The best way is to type the first few letters of a section title and then press **Enter** to insert the title from the list. This is more efficient than scrolling through the list with your arrow keys.

**The section title is not in the list when the Ctrl+N is used. What should I do?**
First check to make sure the clinician selected the correct document type, if not change to the correct document type then check your list. If the title is not in the list, then add it manually. If the clinician did select the correct document type and you still can’t find the title in the list, then add it manually.

### Creating a List

**How do you turn section content into a list?**
Place your cursor in content box, on the line you wish to turn into a list and press **Ctrl+L**.

**How do you separate a paragraph into a list?**
If you need to convert a paragraph into a list, place your cursor on the line where the list should be and press **Ctrl+L**. This changes the paragraph into a one bullet list, then you can go back and hit **Enter** where you want to create new list items. For example, if your paragraph is a list of allergies, press **Enter** after each allergy.

**Why is the list bulleted when it should be numbered?**
The ShadowScribe II Editor only displays bulleted lists when typing from scratch. The appropriate formatting will be applied after you deliver the report via the predefined formatting template, or you can see the formatting applied beforehand by using **Ctrl+Alt+B** to see this in preview with template.

**How do you create an indented list?**
First type **Ctrl+L** on the line or paragraph to start the list. Hit **Enter** to insert your next list item, and then use **Tab** to indent if you need to unindent use **Shift+Tab**, alternatively you can use **Ctrl+M** and **Shift+Ctrl+M** to indent and unindent.

A list was add accidently. It needs to be changed back into text. **How do you do that?**
Just place your cursor in your listed item and press **Ctrl+L**.

### Speeding Up and Slowing Down Dictation

**How do you speed up or slow down the dictation?**
To speed up dictation, press **Ctrl+T**.
To slow down dictation, press **Ctrl+E**.

**How do you return the playback rate to normal?**
Press **Ctrl+R** to return playback to normal.
Formatting: bold, italics, underline

How do you bold, underline, or italicize text?
The most efficient way is using these shortcuts to bold: Shift+Ctrl+B, underline: Shift+Ctrl+U, or italicize: Shift+Ctrl+I.

Playback Settings

How do you control playback when in the ShadowScribe II Editor?
You can control playback using a foot pedal when in the editor. Alternatively, you can also use the shortcuts F2, F3, and F4, which rewind, play/stop, and fast forward the audio.

What is the auto-rewind feature?
When you stop playback, the ShadowScribe II Editor will automatically rewind. This setting allows the user to re-listen to the last word or phrase that was spoken prior to stopping playback. The default setting is 5 seconds.

How do you increase the auto-rewind time further when you stop playback?
To increase or decrease the time go to the Options menu and select the Set Date/Time Values option. Increase or decrease the number of seconds in the Rewind after Pause field.

How do you disable the auto-rewind feature?
To disable the auto-rewind feature, set the Rewind after Pause option to zero.

How far does the ShadowScribe II Editor rewind every time after tapping the rewind pedal (or press F3)
Each time you press the rewind pedal or the shortcut F3, the ShadowScribe II Editor will rewind playback 5 seconds by default.

How do you change the amount of time the ShadowScribe II editor rewinds each time the rewind pedal (or press F3) is pressed?
You can increase or decrease the time by opening the Options menu and select the Set Date/Time Values option. Increase or decrease the number of seconds in the Rewind field.

How far does the ShadowScribe II Editor fast forward every time after tapping the rewind pedal (or press F4)
Each time you press the fast forward pedal or the shortcut F4, the ShadowScribe II Editor will fast forward playback 5 seconds.

How do you change the amount of time the ShadowScribe II editor fast forwards each time the fast forward pedal (or press F4) is pressed?
You can increase or decrease the time by opening the options menu and select the set date/time values option. Increase or decrease the number of seconds in the rewind field.

View Settings

The font size is too small, can it be made bigger?
Yes, to make the font size bigger, go to the editor tool bar and click the zoom percentage drop down. This will magnify the text of the transcription without affecting the actual text that is delivered to the client.

The font in the ShadowScribe II editor is not the right font for my account. How do I change the font?
There is no need to change the font style to match client font size requirements. The ShadowScribe II editor uses a predefined formatting template which controls the style formatting of the structure items within the document, things like sections, subsections, numbered lists, and where content is placed. This template is setup ahead of time by your account manager and is applied when the document is delivered. You can also see the style applied by using Ctrl+Alt+B, preview with template.